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ExtremeCloud IQ - Site Engine Suite Installation

This document provides instructions for installing and launching ExtremeCloud IQ - Site Engine,
and for launching ExtremeCloud IQ - Site Engine applications on remote ExtremeCloud IQ - Site
Engine clients. It also includes information for those upgrading from an earlier version of
Extreme Management Center.

IMPORTANT: Backup the Extreme Management Center database prior to performing the upgrade and
save it to a safe location. Use the Administration > Backup/Restore tab.

General Information
Before you install ExtremeCloud IQ - Site Engine, read the ExtremeCloud IQ - Site Engine
Release Notes. The most recent version of these release notes can be found at the
ExtremeCloud IQ - Site Engine Documentation site. Select Release Notes at the top of the page.

NOTE: The terms engine, gateway, and appliance are used interchangeably throughout ExtremeCloud IQ -
Site Engine documentation.

Operating System Requirements

ExtremeCloud IQ - Site Engine Server Requirements

These are the operating system requirements for the ExtremeCloud IQ - Site Engine server.

Manufacturer Operating System

Linux Red Hat Enterprise Linux WS and ES v6 and v7
Ubuntu 18.04

VMware® (ExtremeCloud IQ - Site Engine Virtual Engine) VMware ESXi™ 6.0 server
VMware ESXi™ 6.5 server
VMware ESXi™ 6.7 server
VMware ESXi™ 7.0 server
vSphere (client only)™

Microsoft® Hyper-V (ExtremeCloud IQ - Site Engine Virtual Engine) Windows® Server 2012 R2
Windows® Server 2016

ExtremeCloud IQ - Site Engine Client Requirements

These are the operating system requirements for remote ExtremeCloud IQ - Site Engine client
machines.

https://emc.extremenetworks.com/


General Information

5 of 36

Manufacturer Operating System

Windows (qualified on the English version of the operating systems) Windows® 10

Linux Red Hat Enterprise Linux WS and ES v6 and v7
Ubuntu 18.04

Mac OS X® El Capitan
Sierra

ExtremeCloud IQ - Site Engine Server and Client Hardware
Requirements
These are the hardware requirements for the ExtremeCloud IQ - Site Engine server and
ExtremeCloud IQ - Site Engine client machines:

ExtremeCloud IQ - Site Engine Server
Small Medium Enterprise Large Enterprise

Total CPUs 1 2 2 2

Total CPU Cores 8 16 24 24

Memory 16 GB 32 GB 64 GB 64 GB

Disk Size 240 GB 480 GB 960 GB 1.92 TB

IOPS 200 200 10,000 10,000

Recommended scale based on server configuration:

Maximum APs 250 2,500 25,000 25,000

MaximumWireless
MUs

2,500 25,000 100,000 100,000

Maximum Managed
Devices

100 1,000 10,000 air gap
8,000 connected

10,000 air gap
8,000 connected

ExtremeControl End-
Systems

N/A 50,000 200,000 200,000

Statistics Retention
(Days)

90 180 180 360

ExtremeAnalytics No Yes Yes Yes

MU Events No Yes Yes Yes

ExtremeCloud IQ - Site Engine Client
Requirements

CPU Speed 3.0 GHz Dual Core Processor

Memory 8 GB (4 GB for 32-bit OS)

Disk Size 300 MB (User's home directory requires 50 MB for file storage)

Java Runtime Environment (JRE) (Oracle Java only) Version 8

Browser1 (Enable JavaScript and Cookies) Microsoft Edge (version 41.16.199.10000.0 in compatibility mode)
Mozilla Firefox (version 34 or later2)
Google Chrome (version 33.0 or later)
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1Browsers set to a zoom ratio of less than 100%might not display ExtremeCloud IQ - Site Engine
properly (for example, missing borders around windows). Setting your browser to a zoom ratio
of 100% corrects this issue.

2When accessing ExtremeCloud IQ - Site Engine using Firefox version 59.0.1 on a non-
touchscreen system on which aWindows operating system is installed, the vertical scroll arrows
do not display.

ExtremeControl Engine Version Requirements
For complete information on ExtremeControl engine version requirements, see Important
Upgrade Information.

Screen Resolution
For optimum display of ExtremeCloud IQ - Site Engine windows and tables, the recommended
minimum screen resolution setting for ExtremeCloud IQ - Site Engine clients is 1024 by 768
pixels. For optimum display of graphs and tables, the recommended minimum screen resolution
setting is 1280 by 1024 pixels.

ExtremeCloud IQ - Site Engine Services
During the ExtremeCloud IQ - Site Engine installation, you can enable the ExtremeCloud IQ -
Site Engine Services, allowing it to run in the background on the ExtremeCloud IQ - Site Engine
server. The service starts automatically by default, and if you shut down and restart the
machine, the service is restarted automatically.

You can also restart the services manually or disable a service so it does not start automatically
when you restart the server.

l SNMPTrap Service - Enables SNMP trap messages to be received and logged when problems or
irregularities are detected on network devices. Only one trap service may be running at a time on a
server. If you are also running a network management system on the server, you may wish to use the
network management trap service.

l TFTP - Enables you to upload and download configuration files, and download firmware to devices. Only
one TFTP service may be running at a time on a machine.

NOTE: The ExtremeCloud IQ - Site Engine TFTP Service does not support IPv6.

Typically, the TFTP service that exists in Linux is disabled; however, if it is enabled, you may wish to
disable it and enable the ExtremeCloud IQ - Site Engine version of TFTP which provides additional
features for ExtremeCloud IQ - Site Engine. If you elect to enable the ExtremeCloud IQ - Site Engine
version on the Linux platform, you must first disable the Linux TFTP service and perform some
configuration as follows:

1. Using a text editor, edit the file /etc/xinetd.d/tftp

2. Set disable = yes
Sample file:
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service tftp
{ flags = REUSE
socket_type = stream
wait = no
user = root
server = /usr/sbin/in.tftp
disable = yes
}

3. Then run: /etc/rc3.d/S56xinetd restart

ExtremeCloud IQ - Site Engine version 22.09.12 supports upgrades from Extreme Management
Center 8.5.7 or ExtremeCloud IQ - Site Engine. The following table details which upgrades are
needed for each NetSight, Extreme Management Center or ExtremeCloud IQ - Site Engine
version prior to upgrading to ExtremeCloud IQ - Site Engine version 22.09.12.

NOTE:
You can change deployment modes from air gap to connected or from connected to air gap
after the upgrade.

Current Version

Upgrade to
ExtremeCloud IQ -
Site Engine version

22.9

8.3.3 8.5.7

ExtremeCloud IQ
- Site Engine (all
versions)

X

Extreme
Management
Center version
8.5.5, 8.5.6 , or
8.5.7

X

Extreme
Management
Center version
8.5.0-8.5.4

X X

Extreme
Management
Center version
8.4.4

X X

*Extreme
Management
Center version
8.4.0-8.4.3

X X
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Current Version

Upgrade to
ExtremeCloud IQ -
Site Engine version

22.9

8.3.3 8.5.7

*Extreme
Management
Center version
8.2.x or 8.3.x

X X

Extreme
Management
Center version
8.0.x or 8.1.x

X X X

NetSight version
7.1 or older

X X X

IMPORTANT:
A backup (Administration > Backup/Restore) of the database must be performed
prior to the upgrade and saved to a safe location.

During the installation (if upgrading using the user interface installer), you have the option to
backup additional user files by selecting a checkbox on the Previous Installation Detected
screen. This option lets you backup user files such as Inventory Manager archive files not
automatically backed up during the install because the backup could take several minutes.

Important Upgrade Considerations
l If your network is using ExtremeAnalytics or ExtremeControl engines, Fabric Manager, or another add-

on feature, you must first perform the ExtremeCloud IQ - Site Engine upgrade to version 22.09.12 and
then add the feature.

l The 4.xx version of the NAC Request Tool is not compatible with the 22.09.12 ExtremeCloud IQ - Site
Engine server. If you are using the NAC Request Tool you need to upgrade the version of NAC Request
Tool to version 22.09.12.

l To upgrade Traffic Sensor from version 21.x, a fresh installation is recommended. If the fresh installation
cannot be used, then please check Knowledge Base for a special procedure.

Upgrading ExtremeControl Engine to Version 22.09.12

General Upgrade Information

You are not required to upgrade your ExtremeControl engine version to 22.09.12 when
upgrading to ExtremeCloud IQ - Site Engine version 22.09.12. However, both ExtremeCloud IQ -
Site Engine and ExtremeControl engine must be at version 22.09.12 in order to take advantage

https://emc.extremenetworks.com/content/oneview/docs/admin/docs/ov_admin_backup.html
https://extremeportal.force.com/ExtrArticleDetail?an=000103629
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of the new ExtremeControl version 22.09.12 features. ExtremeCloud IQ - Site Engine version
22.09.12 supports managing ExtremeControl engine versions 8.4, 8.5, 21.4, 21.9, 21.11, and
22.09.12.

In addition, if your ExtremeControl solution utilizes a Nessus assessment server, you should also
upgrade your assessment agent adapter to version 22.09.12 if you upgrade to ExtremeControl
version 22.09.12.

You can download the latest ExtremeControl engine version at the Extreme Portal. 

Agent Version for NAC Agent-Based Assessment

If you are using onboard agent-based assessment, be aware that the agent version is upgraded
during the ExtremeControl engine software upgrade. If you would like end-systems to update
their agent to the new version, you must configure your assessment test set to test for the new
agent version. Refer to the Important Upgrade Information section in the ExtremeCloud IQ - Site
Engine Release Notes or the agent version included in the ExtremeControl engine software.

Upgrading to Policy Manager 22.09.12
l Policy Manager 22.09.12 only supports ExtremeWireless Controller version 8.01.03 and higher. If you

upgrade to ExtremeCloud IQ - Site Engine 22.09.12 prior to upgrading your controllers, then Policy
Manager does not allow you to open a domain where the controllers already exist or add them to a
domain. A dialog is displayed indicating your controllers do not meet minimum version requirements
and that they must be upgraded before they can be in a domain.

l Following an upgrade to Wireless Controller version 8.31 and higher, a Policy Manager enforce fails if it
includes changes to the default access control or any rules that are set to contain. To allow Policy
Manager to modify the default access control or set rules to contain, you must disable the "Allow" action
in policy rules contains to the VLAN assigned by the role checkbox accessed from the Wireless
Controller's web interface on the Roles > Policy Rules tab. This will allow the enforce operation to
succeed.

Pre-Installation Checklist
Please review the following checklist prior to performing an ExtremeCloud IQ - Site Engine
software installation or upgrade.

Backup database. If performing an upgrade, be sure to backup the Extreme Management
Center database prior to performing the upgrade. Use the Backup/Restore tab to perform the
backup (Administration > Backup/Restore tab).

If you are an existing Extreme Management Center customer, contact your representative to
have your Extreme Management Center license migrated to an ExtremeCloud IQ - Site Engine
license. The ExtremeCloud IQ - Site Engine license also includes licensing for ExtremeAnalytics.

https://extremeportal.force.com/
../../../../../Content/common/releasenotes/release_notes/suite_release_notes.html
../../../../../Content/common/releasenotes/release_notes/suite_release_notes.html
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IMPORTANT:

l For upgrade and installation requirements, as well as configuration considerations, see
ExtremeCloud IQ - Site Engine Configuration and Requirements.

l ExtremeCloud IQ - Site Engine version 22.09.12 receives the licenses from
ExtremeCloud IQ. ExtremeCloud IQ - Site Engine is a subscription-based -only
licensing model. Existing NMS licenses do not provide access to ExtremeCloud IQ -
Site Engine. You can view the status of your license by accessing Administration >
Licenses.

ExtremeCloud IQ - Site Engine Installation
If you are an existing Extreme Management Center customer, contact your representative to
have your Extreme Management Center license migrated to an ExtremeCloud IQ - Site Engine
license. The ExtremeCloud IQ - Site Engine license also includes licensing for ExtremeAnalytics.

Installing ExtremeCloud IQ - Site Engine
Use the following instructions to install ExtremeCloud IQ - Site Engine. Please read through the
following items before beginning the installation.

l The user performing the installation must be the root user. During the installation process you can
specify another user to launch and run the server, if desired.

l If you are installing ExtremeCloud IQ - Site Engine on a Linux system that doesn't support a GUI, see
Performing a Silent Install for information on installing ExtremeCloud IQ - Site Engine without using its
GUI Installation wizard.

l If you are installing ExtremeCloud IQ - Site Engine on a Linux system that requires an operating system
upgrade, you are prompted to upgrade using either an internet connection or locally if no additional
Ubuntu packages need to be installed.

l Prior to beginning installation, verify that your /etc/hosts file has the local host name specified. It should
have an entry that looks like:

127.0.0.1  localhost

l You may encounter a Java exception during the install when becoming the root user with the su -
command. Be sure that your system's root environment has a proper DISPLAY variable setting. The
Installation program reports a Java exception (InvocationTargetException) if the DISPLAY variable is
undefined. If this occurs:

Before using the su - command, set the system display variable to accept a remote display with the
command:
/usr/openwin/bin/xhost +test 111 lll

After using the su - command, set the display variable in the environment where the su - was done.

For C shell: setenv DISPLAY :0.0

For Korn shell: export DISPLAY=:0.0

https://emc.extremenetworks.com/content/common/releasenotes/release_notes/release_note_config.html
#Licenses
#Licenses
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Preparing for CD Installation
Perform the following steps if you will be installing the ExtremeCloud IQ - Site Engine software
from a CD. The following procedures assume that the CD drive from which you are installing is
physically attached to the system where ExtremeCloud IQ - Site Engine is being installed.

1. Insert the ExtremeCloud IQ - Site Engine CD into the CD drive.

2. Use an xterm where you are logged in as root. (Be sure that your system's root environment has a
proper DISPLAY variable setting. For more information see the above note.)

3. Using the cd command, cd to the /mnt/cdrom directory.

4. Using the ls command, check to see if the CD drive is mounted. If no files are listed, issue the following
commands:
mount /mnt/cdrom
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Install and Launch ExtremeCloud IQ - Site Engine
1. Download XIQ-SE Install and Upgrade from the ExtremeCloud IQ section of the Extreme Portal.

2. Use an xterm where you are logged in as root. (Be sure that your system's root environment has a
proper DISPLAY variable setting. For more information see the above note.)

3. Change the permissions on the upgrade file by entering the following command:
chmod u+x File_Name_<version>_install.bin

4. If installing ExtremeCloud IQ - Site Engine on a system on which Ubuntu 18.04 LTS (Bionic Beaver) is
installed, continue to step 5; otherwise, proceed to step 9.

5. Edit the rsyslog.conf file.

6. Uncomment (remove the # from the beginning of the line) for the lines that include imudp/514 and
imtcp/514:

#ENABLE_RSYSLOG_SERVICE
cp /etc/rsyslog.conf /etc/rsyslog.conf.original
sed -i 's/#module(load=\"imudp\")/module(load=\"imudp\")/g' /etc/rsyslog.conf
sed -i 's/#input(type=\"imudp\" port="514")/input(type=\"imudp\" port="514")/g' /etc/rsyslog.conf
sed -i 's/#module(load=\"imtcp\")/module(load=\"imtcp\")/g' /etc/rsyslog.conf
sed -i 's/#input(type=\"imtcp\" port="514")/input(type=\"imtcp\" port="514")/g' /etc/rsyslog.conf
systemctl restart rsyslog

7. Edit the /etc/hosts file.

8. Ensure the ip fqdn hostname line is configured (the last line in the following codeblock):

#IF_DNS_NOT_CONFIGURED
hostnamectl set-hostname <set_your_hostname_here>
domainname <set_your_domain_here>
export HOST_IP=`hostname -i|awk '{print $1}'`
export HOST_FQDN=`hostname -f`
export HOST_NAME=`hostname`
cp /etc/hosts /etc/hosts.original
echo $HOST_IP $HOST_FQDN $HOST_NAME >> /etc/hosts
#
# If DNS is configured on the system ensure the /etc/hosts contains an
# entry of the format:
# <ip> <fqdn> <hostname>
# 192.168.1.150 xmc1804.extremenetworks.com xmc1804

9. Start the Installer.

l If you have downloaded the software, cd to the directory where you downloaded the installer
and start the Installer with the following command:
./ExtremeCloudIQSiteEngine_<version>_64bit_install.bin

https://extremeportal.force.com/ExtrLogin
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l If you are installing from a CD, start the installer with the command:
/mnt/cdrom/ExtremeCloudIQSiteEngine_<version>_64bit_install.bin

10. The ExtremeCloud IQ - Site Engine Installer leads you through a series of windows that ask for all the
information required in order to install ExtremeCloud IQ - Site Engine. You need the following
information for the Installer Program:

l Service Configuration – There are two Service Configuration screens.

o In the first screen, you can specify a user other than root to own the ExtremeCloud IQ -
Site Engine server and its supporting files, if desired. This user becomes the admin user for
the server. Select Use existing user if you already have a user defined on the machine and
enter the user name. Select Create local netsight user if you want to create a new
"netsight" user (netsight is the user name) and enter the password for this new user.
Leave the Use existing user option set to root if you do not want to specify another user.

o In the second screen, enable and start the ExtremeCloud IQ - Site Engine Services. (For
more information on the services offered on the Linux platform, see ExtremeCloud IQ -
Site Engine Services.)

l Destination Directory – This is the path to your ExtremeCloud IQ - Site Engine Installation
Directory. In the Destination Directory window, select Choose to navigate to the directory, or
type the path in manually.

l Operating System Upgrade Method — If your Linux system requires an operating system
upgrade, you are prompted to upgrade using either an internet connection or locally (without an
internet connection) if no additional Ubuntu packages need to be installed:

!!! ATTENTION !!!

We can attempt to upgrade the OS without using the Internet if there were no extra Ubuntu
packages installed. If there were extraneous packages installed, the upgrade will fail with this
method.

Do you want to attempt a local in-place upgrade of the OS and reboot when complete? (Y/n)

When you have finished with this series of windows, ExtremeCloud IQ - Site Engine is installed
according to your specifications.

11. When the installation is complete, the database and server are started automatically. You must wait
until the ExtremeCloud IQ - Site Engine server has started all its various server components before you
can connect to the server and launch the ExtremeCloud IQ - Site Engine applications. On the installation
screen, you see an hourglass icon while the server starts its components. When the server is ready for
connections, the installation screen displays a green check.

12. On the installation screen, select the Show Launch Page link to open the ExtremeCloud IQ - Site Engine
Launch Page.

13. The ExtremeCloud IQ - Site Engine Launch Page opens. At the top of the web page you will see tabs for
the following functions:
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l Home – Launch your ExtremeCloud IQ - Site Engine applications by selecting the names or icons
of any of the listed applications.

l Getting Started – In order to launch your ExtremeCloud IQ - Site Engine applications, you must
have Java Runtime Environment (JRE) 6 (also referred to as 1.6) or higher installed on your
system. This page tells you if you have met this requirement and provides instructions for
installing the Java Runtime Environment (JRE), if required.

l Administration – Provides access to specific server administration functions such as client and
server diagnostics, and server utilities.

14. Verify that you have met the JRE requirement by accessing the Getting Started tab, and install the JRE
according to the instructions on the Install Java tab, if required.

15. Select the Home tab and launch the desired ExtremeCloud IQ - Site Engine application by selecting the
name or icon.

16. A login window appears. ExtremeCloud IQ - Site Engine requires a user login as a way to restrict access
to the ExtremeCloud IQ - Site Engine server, perform audit trails, and assign user capabilities according
to the Authorization Group the user belongs.

a. Select the ExtremeCloud IQ - Site Engine server to which you wish to connect.

b. Enter your username.

c. Enter your password and select OK.

NOTES: The initial user to log in must be the user that performed the ExtremeCloud IQ - Site
Engine installation, which is either root or the user defined in the Service
Configuration screen during the installation. This is because the ExtremeCloud IQ -
Site Engine server has a single pre-defined user. After the initial user has logged in,
additional users can be defined.

The password for the root user does not expire. To configure the password to age so
it expires after 60 days, see Configure Your Password to Expire.

17. The application main window opens.

Performing a Silent Install
If you are installing ExtremeCloud IQ - Site Engine on a Linux system that doesn't support a GUI,
you must add the cli flag (--cli) to the install command, in order to allow the ExtremeCloud IQ -
Site Engine installer to prompt for any required input.

Start the installation with the following command:

./ExtremeCloudIQSiteEngine_<version>_64bit_install.bin --cli

If you are installing as a user other than root, you must use the --user command to specify the
different user. The user must already be configured on the machine before you install. For
example:
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./ExtremeCloudIQSiteEngine_<version>_64bit_install.bin --cli --user
<username>

To perform the install and create a new local "netsight" user (where netsight is the user name),
use the --password command to set the password for the new "netsight" user. For example:

./ExtremeCloudIQSiteEngine_<version>_64bit_install.bin --cli --password
<password>

Select the deployment mode and licensing for ExtremeCloud IQ -
Site Engine
After installing or upgrading to ExtremeCloud IQ - Site Engine, you need to select your
deployment mode and licensing for ExtremeCloud IQ - Site Engine. Refer to First log in to
ExtremeCloud IQ - Site Engine for the procedure.

Post Installation Procedure for Ubuntu 18.04 LTS (Bionic Beaver)
If installing ExtremeCloud IQ - Site Engine on a system on which Ubuntu 18.04 LTS (Bionic
Beaver) is installed, follow this procedure when ExtremeCloud IQ - Site Engine is installed:

1. Open a command prompt on the ExtremeCloud IQ - Site Engine server.

2. Enter cp /var/Extreme_Networks/.netsight /var/Extreme_
Networks/.netsight.original.

3. Enter export HOST_IP=`hostname -i|awk '{print $1}'`.

4. Enter sed -i "\$aJBOSS_HOSTNAME=$HOST_IP" /var/Extreme_Networks/.netsight.

5. Install OpenSSH for SCP-based archives support and allow root login:

a. Open the /etc/ssh/sshd_config file and change PermitRootLogin to yes.

b. Enter apt-get install openssh-server.

6. Allow root access to the ExtremeCloud IQ - Site Engine server via SSH.

a. Enter cp /etc/ssh/sshd_config /etc/ssh/sshd_config.original.

b. Enter sed -i 's/#PermitRootLogin prohibit-password/PermitRootLogin
yes/g' /etc/ssh/sshd_config.

Restoring a Database from a Windows Server to a Linux Server
This section describes several ExtremeCloud IQ - Site Engine configuration changes required if
you are moving your ExtremeCloud IQ - Site Engine installation from aWindows platform
system to a Linux platform system. The steps are performed after restoring your database to
the new server.

In addition, there are two changes that must be made in the legacy Console java application and
one change in the legacy Inventory Manager application.
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Console

Use the following instructions to change the location of syslog and trap information to the new
location on the Linux system.

Syslog

Change the Syslog Log Manager to point to the new location on the Linux system. This allows
the display of syslog information in the Syslog Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2. Select the Syslog entry under Available Log Managers, and select the Edit button. The Log Manager
Parameters window opens.

3. Change the path in the Log Directory field to /var/log/syslog.

4. Change the Pattern to Red Hat LINUX Syslog Pattern.

5. Select OK.

Traps

Change the Traps Log Manager to point to the new location on the Linux system. This allows the
display of trap information in the Traps Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2. Select the Traps entry under Available Log Managers, and select the Edit button. The Log Manager
Parameters window opens.

3. Change the path in the Log Directory field to %logdir%/traps.

4. Select OK.

Inventory Manager

If you are using Inventory Manager, you need to change the Data Storage Directory path to
point to the new location on the Linux system. The Data Storage directory is where all Inventory
Manager data is stored, including capacity planning reports, configuration templates, archived
configurations, and property files.

1. From the Inventory Manager menu bar, select Tools > Options. Expand the Inventory Manager options
folder and select Data Storage Directory Path.

2. Change the path to the correct new location. On a default Linux install, the path would be:
<user's home directory>/appdata/InventoryMgr

3. Select OK.

Systems with Multiple NICs
This section provides instructions for configuring ExtremeCloud IQ - Site Engine servers with
multiple NICs (Network Interface Cards). During the startup process, the ExtremeCloud IQ - Site



Uninstalling ExtremeCloud IQ - Site Engine

17 of 36

Engine server automatically binds to the first available NIC, which may not be the correct
interface for the server to use. In addition, changes on the network can cause the server to bind
to an incorrect interface, should the server restart during a change.

If the system has multiple NICs installed, it is a good practice to either:

l configure the server to bind to a preferred IP address, if using only one interface for connections or

l configure multiple network interfaces, if using more than one interface for connections.

This ensures that local and remote clients, as well as ExtremeControl engines, are able to
connect to the ExtremeCloud IQ - Site Engine server.

Binding to One Interface
If the ExtremeCloud IQ - Site Engine server has multiple NICs installed but only one interface is
used to access ExtremeCloud IQ - Site Engine, use the following instructions to configure the
preferred interface for the ExtremeCloud IQ - Site Engine server.

Configure the ExtremeCloud IQ - Site Engine server to bind to the correct IP address.

1. Open the /var/Extreme_Networks/.netsight file. Edit the line JBOSS_HOSTNAME=<server
IP> to add the correct NIC IP address.

2. Restart the ExtremeCloud IQ - Site Engine server.

NOTE: User preferences and application data (such as FlexViews and MIBs) for remote clients are stored in
the following local directory on the client machine: C:\Documents and
Settings\<username>\Application Data\NetSight.

Uninstalling ExtremeCloud IQ - Site Engine
Use the procedures below to uninstall your ExtremeCloud IQ - Site Engine Suite of products.
The uninstall removes all ExtremeCloud IQ - Site Engine data from the database. Be sure to
backup your database prior to uninstalling.

Navigate to the <install directory>/uninstaller directory and start the Uninstaller by issuing the
command:
./uninstall.sh

Extreme Networks Support
If you require assistance, contact Extreme Networks Global Technical Assistance Center using
one of the following methods.

Web www.extremenetworks.com/support/

https://www.extremenetworks.com/support/
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Phone 1-800-872-8440 (toll-free in U.S. and Canada) or 1-603-952-5000
For the Extreme Networks Support phone number in your country:
www.extremenetworks.com/support/contact/

Email support@extremenetworks.com

https://www.extremenetworks.com/support/contact/
mailto:support@extremenetworks.com
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ExtremeCloud IQ - Site Engine Licensing

ExtremeCloud IQ - Site Engine includes all the features and functionality of Extreme
Management Center. If you are an existing Extreme Management Center customer, contact your
representative to have your Extreme Management Center license migrated to an ExtremeCloud
IQ - Site Engine license. The ExtremeCloud IQ - Site Engine license also includes licensing for
ExtremeAnalytics.

NOTES:

l ExtremeCloud IQ - Site Engine is a subscription-based -only licensing model.

l is not compatible with ExtremeCloud IQ - Site EngineExtremeCloud IQ Connect level account.
The Pilot level is mandatory.

You can view ExtremeCloud IQ and ExtremeCloud IQ - Site Engine license information by
accessing Administration > Licenses.

This Help topic includes information on the following:

l Licensing for Devices in Connected Mode

l Licensing for Devices in Air Gap Mode

l Revoke Air Gap License

l License Limits and Violations

l Licensing for ExtremeControl

There are three tiers of licenses for ExtremeCloud IQ - Site Engine and devices:

l Pilot - Natively supported Extreme devices

l Navigator - 3rd party devices, Extreme Campus Controller wireless devices, WiNG wireless devices, and
devices not natively supported by ExtremeCloud IQ - Site Engine

l No License - Status-Only devices

ExtremeCloud IQ - Site Engine can be deployed in two ways, using connected mode or air gap
mode:

l Connected mode:

l ExtremeCloud IQ - Site Engine uses ExtremeCloud IQ to determine if you meet or exceed the
license limits for each license type.

l All ExtremeCloud IQ - Site Engines connected to the same customer account share a pool of
licenses, one serial number consumes one license entitlement, regardless of the number of
monitoring entities.

l ExtremeCloud IQ - Site Engine shares information with ExtremeCloud IQ.

l ExtremeCloud IQ can cooperate with ExtremeCloud IQ - Site Engine.

#Licenses
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l Air gap mode:

l ExtremeCloud IQ - Site Engine does not require internet access.

l ExtremeCloud IQ - Site Engine uses a license file to determine if you meet or exceed the license
limits for each license type.

l ExtremeCloud IQ - Site Engines can not share licenses.

NOTE:

Devices that do not have serial numbers or MAC addresses in Extreme
Management Center must be Rediscovered after you upgrade to
ExtremeCloud IQ - Site Engine in connected mode before they can be
onboarded to ExtremeCloud IQ.

If your number of devices exceeds your licenses available, ExtremeCloud IQ -
Site Engine transitions to a license violation state and your access to
ExtremeCloud IQ - Site Engine features and functionality is degraded. To
resolve the license shortage you need to access the Extreme Networks
License Portal or ExtremeCloud IQ to evaluate the quantities of available
Pilot, Navigator, and NAC licenses versus the number of licenses required by
ExtremeCloud IQ - Site Engine.

Licensing for Devices in Connected Mode
When ExtremeCloud IQ - Site Engine has been onboarded, it starts sending requests to add the
devices from its database to ExtremeCloud IQ.

As devices are added and discovered in ExtremeCloud IQ - Site Engine, they are onboarded to
ExtremeCloud IQ, with a request for a license of the appropriate tier (Navigator, Pilot or No
License) that each device will require.

Devices may be marked as Unmanaged in ExtremeCloud IQ, which means they are not using a
license and available features are very limited.

The following grid details the type of license required by each device and engine type:

Device Type License Tier Type
Number of
Licenses Per

Device

Extreme-supported Device (Includes
VOSS/Fabric Engine, SLX, Extreme Access
Series, VDX Series, Fabric Manager, Universal
Platform Fabric Engine, Universal Platform VOSS,
Universal Platform Switch Engine, Universal
Platform EXOS, Summit Series, ERS Series, 200
Series, 7100 Series, A Series, B Series, C Series, K
Series, S Series, ICX Series, Security Appliances,
MLXe Series)

Pilot 1

../../../../../Content/oneview/install/onboarding_XIQ.htm
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Device Type License Tier Type
Number of
Licenses Per

Device

Extreme-supported Chassis (Includes S series, K
series, N series, E series, Black Diamond, Black
Diamond X, X series, VSP series, MLXe series,
VDX series, SLX series)

Pilot 1 for each chassis

ExtremeControl engine Pilot 1

ExtremeAnalytics engine Pilot 1

ExtremeCloud IQ - Site Engine* Pilot 1

vSensor Pilot 1

All Other Devices (Includes Non-Extreme
Device)

Navigator 1

Devices with Ping-Only profile No License 0

*There is one license required for the ExtremeCloud IQ - Site Engine itself. If there are
more ExtremeCloud IQ - Site Engine, then only one license is consumed.

NOTE:
For HiveOS APs (IQE) and Dell N-Series, a Pilot license is required, but currently not
enforced in ExtremeCloud IQ - Site Engine. These are not onboarded to ExtremeCloud IQ
through ExtremeCloud IQ - Site Engine.

Licensing for Devices in Air Gap Mode
ExtremeCloud IQ - Site Engine uses licenses stored locally in a license file. This ensures
ExtremeCloud IQ - Site Engine does not require an internet connection to verify licenses are
available as you add devices.

NOTE:
Licenses in one installation of ExtremeCloud IQ - Site Engine in air gap mode cannot be
shared with other installations of ExtremeCloud IQ - Site Engine.

As devices are added and discovered in ExtremeCloud IQ - Site Engine, they consume a license
of the appropriate tier (Navigator, Pilot or No License) that each device requires against the
total listed in the license file.

Devices may be marked as Unmanaged, which means they are not using a license and available
features are very limited.

The following grid details the type of license required by each device and engine type:

../../../../../Content/oneview/docs/admin/docs/t_ov_admin_license.html
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Device Type License Tier Type
Number of
Licenses Per

Device

Extreme-supported Device (Includes
VOSS/Fabric Engine, SLX, Extreme Access
Series, VDX Series, Fabric Manager, 200 Series,
ICX Series, Security Appliances, MLXe Series,
Extreme Access Series, VDX Series, HiveOS
(IQE), Dell N-Series)

Pilot 1

Extreme-supported Device (Universal Platform
Fabric Engine, Universal Platform VOSS,
Universal Platform Switch Engine, Universal
Platform EXOS, Summit Series, ERS Series, A
Series, B Series, C Series, 7100 Series)

Pilot 1 for each unit

Extreme-supported Chassis (Includes S series, K
series, N series, E series, Black Diamond, Black
Diamond X, X series, VSP series, MLXe series,
VDX series, SLX series)

Pilot 1 for each chassis

ExtremeControl engine Pilot 1

ExtremeAnalytics engine Pilot 1

ExtremeCloud IQ - Site Engine* Pilot 1

vSensor Pilot 1

All Other Devices (Includes Non-Extreme
Device)

Navigator 1

Devices with Ping-Only profile No License 0

*There is one license required for the ExtremeCloud IQ - Site Engine itself. If there are
more ExtremeCloud IQ - Site Engine, then only one license is consumed.

Revoke Air Gap License

NOTE: Amaximum of 10 Air Gap licenses can be revoked in one revocation file.

Follow this procedure to revoke your Air Gap license.

1. Open Administration > Licenses or enter this URL.
https://<Server>:/8443/xiqLicenseSetup.jsp?setupMode=Airgap



License Limits and Violations

23 of 36

2. Select either the Pilot, Navigator, or NAC license to revoke.

ExtremeCloud IQ - Site Engine generates a revocation file.

3. Download the file to your computer.

4. Log into the Extreme Portal (https://extremeportal.force.com/ExtrCloudLicenseLanding).

5. Select Assets > Cloud Licenses Home > Revoke License.

6. Upload the revocation file and select Submit.

The revoked licenses are returned to the license pool. Contact support if you encounter an error.
You will need to provide the revocation file (.rvk) and the error message.

License Limits and Violations
For each request to add a device to ExtremeCloud IQ - Site Engine:

l In connected mode: ExtremeCloud IQ determines if there are enough licenses of that type available.

l In air gap mode: ExtremeCloud IQ - Site Engine uses the license file to determine if there are enough
licenses of that type available.

As a result for both modes, one of the following actions happens:

https://extremeportal.force.com/ExtrCloudLicenseLanding
https://www.extremenetworks.com/support/
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l If there are enough licenses, device onboarding is successful.

l If there are not enough Navigator licenses, a Pilot license is used instead.

l If there are not enough Pilot licenses, the request is considered a license violation.

NOTE:
When an evaluation license is used for ExtremeCloud IQ - Site Engine, all devices are
managed with Pilot licenses.

To correct a license limit violation:

l In connected mode: You must acquire more licenses (and, when the updated licenses are available in
ExtremeCloud IQ, they are used by ExtremeCloud IQ - Site Engine).

l In air gap mode: You must acquire more licenses by generating a new licensing file from the licensing
portal, then install the licensing file in ExtremeCloud IQ - Site Engine.

Devices Marked as Unmanaged
When devices are marked as Unmanaged in ExtremeCloud IQ, they are also Unmanaged in
ExtremeCloud IQ - Site Engine.

Onboarded Unmanaged devices are indicated in the XIQ Onboarded column of the Network >
Site > Device table by a red X.

For more details on the Network > Site > Device table, visit Onboarding Unmanaged Devices.

Licensing for ExtremeControl (Network Access Control)
If the ExtremeCloud IQ - Site Engine was onboarded to ExtremeCloud IQ, ExtremeCloud IQ
provides the Network Access Control (NAC) entitlements to ExtremeCloud IQ - Site Engine.

#XIQ_onboard
../../../../../Content/oneview/install/onboarding_XIQ.htm
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There is an option to allocate a portion of the available license pool in ExtremeCloud IQ. The full
100% NAC entitlements should be allocated automatically to the first ExtremeCloud IQ - Site
Engine. If there are more Site Engines, for example, a lab instance and a production instance,
then the NAC entitlements allocation can be changed in the ExtremeCloud IQ GUI. It is
recommended to check the NAC entitlements allocation in ExtremeCloud IQ.

If the ExtremeCloud IQ - Site Engine is operated in air gap deployment mode, the licensed
quantity for ExtremeControl is provided through a license file. The license file is generated in
Extreme Portal. The licensed quantity for ExtremeControl varies depending on whether
ExtremeCloud IQ - Site Engine is initially installed or it was upgraded from the Extreme
Management Center.

After Upgrading from Extreme Management Center
If you are upgrading from Extreme Management Center to ExtremeCloud IQ - Site Engine, the
licensing and capabilities of ExtremeControl do not change. The following are included in the
licenses:

l NMS-ADV License includes 500 Access Control End-Systems and 50 Guest and IoT Manager
(GIM) licenses.

l NMS-xx License includes 250 Access Control End-Systems and 25 GIM licenses.

NOTE:
If your version of ExtremeControl contains NMS or NMS-ADV licenses described above and licenses are
used through ExtremeCloud IQ (in Connected mode) or in a locally stored license file (in Air Gap
mode), ExtremeControl will sum those licensed quantities.

Upon Initial Installation
If you are completing an initial install of ExtremeCloud IQ - Site Engine, there is no end-system
license included. The evaluation license can be generated on the Extreme Portal which includes
unlimited end-systems and Guest and IoT Manager (GIM) licenses.
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Logging into ExtremeCloud IQ - Site Engine

In connected mode, ExtremeCloud IQ - Site Engine gets licenses through ExtremeCloud IQ.
ExtremeCloud IQ acts as a license proxy between ExtremeCloud IQ - Site Engine and Extreme
Portal. Therefore, your ExtremeCloud IQ needs to be linked to your license entitlements in the
Extreme Portal before your ExtremeCloud IQ - Site Engine can be onboarded to ExtremeCloud
IQ and consumes licenses via ExtremeCloud IQ. In Air Gap deployment mode, ExtremeCloud IQ
- Site Engine utilizes these licenses based on a license file.

Post upgrade from Extreme Management Center Version
8.5.5 or 8.5.6
When the Extreme Management Center is onboarded to ExtremeCloud IQ using the soft launch
feature, you need to remove Extreme Management Center from ExtremeCloud IQ before
onboarding ExtremeCloud IQ - Site Engine.

Initial installation of ExtremeCloud IQ - Site Engine or
upgrading from Extreme Management Center
Follow these steps to launch ExtremeCloud IQ - Site Engine:

1. Enter this https://<IP Address>:8443 in your browser.

2. Enter your ExtremeCloud IQ - Site Engine login credentials and select Login. These are the credentials
you configured during the installation



Initial installation of ExtremeCloud IQ - Site Engine or upgrading from Extreme Management

27 of 36

3. Accept the License Agreement and select Next.

4. Select your deployment mode. Refer to the XIQ-SE Activation document for licensing information.

l Connected mode - Onboard to ExtremeCloud IQ - Site Engine - In connected deployment mode,
ExtremeCloud IQ - Site Engine utilizes these licenses through connection to ExtremeCloud IQ. It
is required to link your Extreme Portal to ExtremeCloud IQ. Once those are linked together, you
can use the licenses you purchased in both ExtremeCloud IQ and ExtremeCloud IQ - Site Engine.

l Air Gap mode - Enter entitlement(s) for air gapped ExtremeCloud IQ - Site Engine - In air gap
deployment mode, ExtremeCloud IQ - Site Engine utilizes these licenses based on a license file.
During the generation of the license file, the licenses are assigned to the locking ID of
ExtremeCloud IQ - Site Engine.

https://documentation.extremenetworks.com/netsight/XIQ-SE/21.11.11/Supplemental Resources/XIQ-SE_Activation_Instructions.pdf
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NOTE:
TheWelcome screen provides a link to the procedure for restoring ExtremeCloud IQ -
Site Engine from backup.

5. Click Next.

6. Depending on the deployment mode you selected, you will do one of the following:

l For Connected mode onboarding of ExtremeCloud IQ - Site Engine to ExtremeCloud IQ, enter
the ExtremeCloud IQ email address and password and select Onboard. If your environment
requires HTTP Proxy or other advanced settings, select the Advanced link. If you do not have an
ExtremeCloud IQ account, select the Register Here link.

https://emc.extremenetworks.com/content/oneview/install/restore_binary_backup.htm
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l For Air Gap deployment, drag and drop your entitlements to this screen.



Onboarding Devices (Connected mode only)

30 of 36

7. Click Onboard (Connected mode) or Continue (Air Gap mode). ExtremeCloud IQ - Site
Engine is ready to use.

You can now access ExtremeCloud IQ - Site Engine.

NOTE:
If you need to convert your deployment between Connected or Air Gap mode,
see Convert from Connected to Air Gap deployment or Convert from Air Gap to
Connected deployment.

Onboarding Devices (Connected mode only)
When ExtremeCloud IQ - Site Engine is onboarded, it starts sending requests to add the devices
from its database to ExtremeCloud IQ. Cloud Configuration Groups are created in
ExtremeCloud IQ that match User Device Groups in ExtremeCloud IQ - Site Engine.

NOTE:
Devices with IPv6 addresses in ExtremeCloud IQ - Site Engine will not be
onboarded as locally-managed devices in ExtremeCloud IQ. Only devices with
IPv4 addresses qualify.

As devices are added and discovered in ExtremeCloud IQ - Site Engine, they are onboarded to
ExtremeCloud IQ, with a request for a license of the appropriate tier (Navigator, Pilot or No
License) that each device will require.

If devices that are onboarded are included in User Device Groups in ExtremeCloud IQ - Site
Engine, they are also included in Cloud Configuration Groups in ExtremeCloud IQ that match the
devices' assigned User Device Groups in ExtremeCloud IQ - Site Engine.

Cloud Configuration Groups are updated when devices are added to User Device Groups (either
by user action or by API call). Cloud Configuration Groups are also updated when devices are
removed from a User Device Group or deleted from ExtremeCloud IQ - Site Engine.

NOTE:

Cloud Configuration Group names include User Device Group parent names
(other than "My Network") and are prefixed with "XIQSE-".
The Cloud Configuration Group names will be shortened to fit the limit of 128
characters.

View the ExtremeCloud IQ - Site Engine and ExtremeCloud IQ Onboarding Flowchart for a
detailed chart on how devices are onboarded to ExtremeCloud IQ and managed by
ExtremeCloud IQ - Site Engine.

XIQ Onboarded Status for Devices (Connected mode
only)
After an attempt is made to onboard a device, the XIQ Onboarded column in the table Network
> Site > Device) indicates the status of the onboarding attempt.

https://emc.extremenetworks.com/content/oneview/install/connect_to_air_gap.htm#connect_air_gap
../../../../../Content/oneview/install/convert_to_connected.htm
../../../../../Content/oneview/install/convert_to_connected.htm
#lic_for_devs
https://documentation.extremenetworks.com/netsight/XIQ-SE/Supplemental Resources/XIQ-SE and XIQ Onboarding.png
#XIQ_onboard
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l Black check mark - Indicates that the device is onboarded to ExtremeCloud IQ.

l Red X - Indicates the device is onboarded but Unmanaged, which means it is not using a license, it has
read-only device-level support, and available features in ExtremeCloud IQ - Site Engine are limited.
Other functionality, including Status Polling, Historical Device + Port Statistics Collection, Existing
Scheduled Tasks, and Archives, are supported for devices with Unmanaged status, but these devices
cannot be configured for new tasks or new archives.

NOTE:

In ExtremeCloud IQ - Site Engine version 22.09.12, only use ExtremeCloud
IQ to set an ExtremeCloud IQ - Site Engine onboarded device to
Unmanaged as a temporary measure while you obtain more licenses.

If you mark a device as Unmanaged so it does not trigger a license limit
violation, you can then access ExtremeCloud IQ - Site Engine and delete
the device before the license violation occurs.

You can perform an enforce for an ExtremeControl engine with an
Unmanaged status; however, if the device has an Unmanaged status, then
the enforce does not reconfigure the device and changes are not written
to the device.

When devices are marked as Unmanaged in ExtremeCloud IQ, they are also Unmanaged in
ExtremeCloud IQ - Site Engine.

In addition, existing ExtremeAnalytics functionality for devices with an Unmanaged status
is still supported, but only with existing configuration.

l Blank - Indicates the device is not successfully onboarded to ExtremeCloud IQ from the ExtremeCloud
IQ - Site Engine because either it is already onboarded to ExtremeCloud IQ (either from another
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ExtremeCloud IQ - Site Engine or by using the IQ Agent to connect directly), or because ExtremeCloud
IQ - Site Engine lost its connection to ExtremeCloud IQ.

NOTE:
If a device's status is Blank, it has limited features available in
ExtremeCloud IQ - Site Engine because management of the device is
owned by ExtremeCloud IQ.

l N/A - Indicates the device is not eligible to be onboarded to ExtremeCloud IQ because it does not have
a valid serial number or MAC address, or Extreme does not yet offer onboarding support for the device.

NOTE:

If ExtremeCloud IQ - Site Engine does not recognize a device’s serial
number or MAC address, right-click on the device and select Rediscover
to attempt to discover the device’s serial number or MAC address. When
the device's serial number or MAC address is discovered, it can be
onboarded to ExtremeCloud IQ during the next onboarding cycle.

IMPORTANT:

After you complete these procedures, you must return
to the next step Post Installation Procedure for Ubuntu
18.04 LTS (Bionic Beaver)ExtremeCloud IQ - Site Engine
Suite Installation.
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Convert from Connected to Air Gap deployment

Follow this procedure if you need to convert from Connected mode to Air Gap mode.

1. Delete ExtremeCloud IQ - Site Engine from ExtremeCloud IQ

2. In the next 48 hours, all subscriptions will be deactivated automatically. During this time
period:

l The ExtremeCloud IQ - Site Engine will report Connection Lost with
ExtremeCloud IQ

l New devices cannot be added to ExtremeCloud IQ - Site Engine

3. Log in to ExtremeCloud IQ - Site Engine

4. Go to Air Gap License Entitlements using
HTTPS://<SiteEngineIP>:8443/xiqLicenseSetup.jsp?setupMode=Airgap

5. Copy the ExtremeCloud IQ - Site Engine serial number (Locking ID, UUID) from the entitlements screen



XIQ Onboarded Status for Devices (Connected mode only)

34 of 36

6. Generate a license file. Follow the license generation procedure in section Air gap deployment mode:
Generate and Install the License File found in the Activation Instructions guide

7. Drag and drop the license file in the Entitlements section of the Air Gap License Entitlements screen (see
step 4).

8. Click Continue

9. Restart your ExtremeCloud IQ - Site Engine server.

After the restart, your Site Engine is ready to use.

https://documentation.extremenetworks.com/netsight/XIQ-SE/22.3.10/Supplemental Resources/XIQ-SE_Activation_Instructions.pdf
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Convert from Air Gap to Connected deployment

Follow this procedure if you need to convert from Air Gap mode to Connected mode.

1. Check the connectivity from ExtremeCloud IQ - Site Engine to ExtremeCloud IQ. If there is a
connectivity issue, fix it before continuing.

2. Make all of the devices managed or delete all unmanaged devices from ExtremeCloud IQ -
Site Engine.

3. Revoke all Air Gap licenses. For information on how to revoke the licenses, see Revoke Air Gap License.

4. Go to HTTPS://<SiteEngineIP>:8443/xiqLicenseSetup.jsp?setupMode=Auto

5. If you do not have an ExtremeCloud IQ account, then you need to create one.
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6. If your ExtremeCloud IQ account is not linked to your Extreme Portal account, follow the procedure in
the Activation Instructions.

7. Onboard ExtremeCloud IQ - Site Engine to ExtremeCloud IQ. For more information on how to onboard
Site Engine, see Logging into ExtremeCloud IQ - Site Engine.

8. Restart your ExtremeCloud IQ - Site Engine server.

After the restart, your Site Engine is ready to use.

https://emc.extremenetworks.com/content/oneview/install/se_activation_instructions.htm
https://emc.extremenetworks.com/content/oneview/install/onboarding_xiq.htm#First
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